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RGB Color Spaces

In this lesson, we’re going to cover RGB color spaces, also known as RGB work-
ing spaces. This is a critical topic to understand if you want to work effectively 
in Photoshop. The RGB color space is going to control how saturated colors can 
become in your image. Understanding the color space will help you understand 
why colors may not look the same from one document to another. 

What’s happening behind the scenes

Photoshop’s Info panel will show you what’s going on behind the scenes in your 
image. If the Info panel is not already visible in your interface, you can access it 
by going to the Window menu and choosing Info. The Info panel presents you 
with different series of numbers. The upper left readout reflects what mode your 
picture is in. 

Color Spaces Knowing that an image is RGB is truly not enough information to 
tell you which mode it’s in. The image is actually in what we refer to as a color 
space. A color space is not only the name of the mode, but a way of specifying 
what colors of red, green and blue you’re working with. 

Whenever you see the same image or video presented differently across multiple 
screens, it means that there is no effective color management. Color manage-
ment tries to make the colors look consistent across various different screens.

When you look at the Info panel 
while hovering your cursor over 
your image, the numbers in the 
upper left will tell you what lev-
els of red, green and blue are 
required to make the color that 
is under your cursor (providing 
you’re working in RGB), but it’s 
not enough information to truly 

The Info panel shows what’s going on behind the 
scenes in your image. 
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describe the color. You also need to know what color space you’re working in. 
You can specify that the Info panel show you the current color space by clicking 
on the little side menu in the upper right corner of the panel, choosing Panel Op-
tions from the dropdown menu and then turning on the Document Profile check 
box. This will give you a readout of your current color space at the bottom of the 
Info panel. 

You will also find the number values that make up a color within the Color Picker, 
which you can easily access by clicking on the foreground color swatch at the 
bottom of the Tool Bar. 

Consistent colors across screens

A screen uses red, green and blue light to display the colors you see and each 
screen uses a different set of those three colors. The color chart (on the next page) 
shown represents the most vivid colors your eyes are capable of seeing. The set 

Left: You can tell the Info panel to provide a 
readout of the current color profile by going 
to the side menu on the panel, choosing Pan-
el Options and then turning on the Document 
Profile check box. Above: The RGB color num-
bers can also be found within the Color Picker
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of black dots represent the red, green and blue 
hues used on an older Apple display. The set of 
black dots with the white outline represent the 
red, green and blue hues used on the new iMacs 
or iPhones. The set of white dots represent the 
red, green and blue hues used on an NEC display. 
As you can see, each of the screens are using 
red, green and blue, but they’re using different 
versions of those colors in order to present the 
image. This causes subtle (and sometimes not so 
subtle) differences from screen to screen. 

In order to display our colors accurately, we’ll cre-
ate our images not based on the monitor they’ll 
be displayed on, but by using a consistent stan-
dard. Then, the color management system that 
we use will figure out how to transpose that stan-
dard for all the different displays. 

Working space choices

Let’s take a look at the standard choices we have 
when choosing an RGB working space.

The smallest working space, meaning the space that 
uses the most restricted range of colors, is the sRGB 
space. Looking at the sRGB diagram, the three 
points of the triangle represent the red, green and 
blue colors used in this color space. Everything in-
side this triangle represents the different colors you 
can create.  

The Adobe RGB color space is a bit larger than the 
sRGB space, and you can see from the diagram that 
it includes a wider variety of green hues. When you 

This chart represents the most 
vivid colors our eyes are capable 
of seeing. The dots represent the 
capabilities of different displays. 

The three points on this RGB 
triangle represent the most 
vivid reds, greens and blues 
created by the sRGB color 
space. 
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type in the highest value possible for Green within the color picker, you can see 
that the resulting hue would be different in the Adobe RGB space than it would 
be in the sRGB space. 

ProPhoto RGB is the widest color space. The red, green and blue points each ex-
tend much farther than they do for the other color spaces. The shape of color un-
der the triangles represents the range of colors you can see with your eyes. You’ll 
notice that the ProPhoto RGB spaces extends beyond the shape of color and 
that’s because it can create colors that your eyes will never be able to perceive.  

Color spaces and screens

Different screens will display different ranges of color, and it’s important to know 
how many colors your screen can work with. The older Thunderbolt display can 
incorporate a certain amount of colors. The P3 display can show more, and the 
NEC display can show even more yet. Note that a high quality monitor will tell 
you what percentage of the Adobe RBG color space it can display. The higher 
this percentage is, the better the display. If the monitor does not tell you what the 
percentage is, it’s likely not a high quality display. 

Far Left: The outer trian-
gle represents the most 
vivid reds, greens and 
blues that can be creat-
ed by the Adobe RGB 
color space. 

Directly Left: These 
triangles represent the 
range of colors you can 
create in a document, 
depending on which col-
or space you’re working 
in. The triangles repre-
sent the sRGB, Adobe 
RGB and ProPhoto RGB 
color spaces.
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Color spaces and printers

Often times, the end result of your work on an image is the print. Each printer has 
a certain range of colors that it’s capable of reproducing, and it’s nice when we 
can have all of those colors incorporated in our documents. Ideally, you want the 
color space of your document to be close to the same size as the color space for 
your printer. 

Printing on a printing press When working with a printing press, the goal is to 
be economical with ink. Because of that, you usually don’t have as wide a range 
of colors. 

News Print Looking at the range of colors you can use with news print, it’s clear 
that the color space doesn’t matter because every color space is capable of cre-
ating the small range of colors a news press would use. The shape that represents 
news print fits inside all of the color space triangles. 

Sheet-fed printing press When printing on a sheet-fed printing press with un-
coated paper, the range of colors we can print is a little larger, and the shape that 
represents those colors extends beyond the sRGB triangle slightly. This means 
that it can print some colors that the sRGB space is not capable of creating. For 
this reason, we’d probably use the Adobe RGB space because it is big enough to 
contain the range of colors this type of printer can produce.

The light shapes represent the colors that can be displayed on three different types of print-
ers. From left: News print, a sheet-fed printing press and a sheet-fed printing press with 
coated paper. 
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When printing on a sheet-fed printing press with coated paper, the quality is 
higher and, looking at the graphic in the video, you can see that the shape ex-
tends way beyond the bounds of the sRGB space. In order to best represent the 
vivid colors, we’d need to use Adobe RGB mode instead of sRGB. 

Printing on an inkjet printer This is the type of printer you would have at home 
and the kind that is used when you order photographs to be printed from a pho-
to lab. Because these printers aren’t producing 
the mass quantities that a printing press is pro-
ducing, they can use higher quality ink and use a 
wider range of colors. In the video, we show the 
diagrams for a few different inkjet printers. Most 
of them can print a range of colors that extends 
far beyond the triangle representing sRGB. This 
means that the sRGB color space will limit you 
rather dramatically in terms of colors you can use 
in your images. Many of these printers can pro-
duce a color space that even extends beyond the 
bounds of the Adobe RGB color space. For this 
reason, it could be best to use the ProPhoto color 
space to ensure that we can create all of the col-
ors that our printer is capable of producing. 

This is where things can start to get tricky. In using 
the ProPhoto RGB color space, we can create all 
of the colors our printer is capable of producing, 
but we are limited in what our screen can display. 
This means that some printers can reproduce col-
ors that the screen can NOT reproduce. 

The white shapes represent the 
colors that two different inkjet 
printers are capable of produc-
ing. You can see that the color 
ranges extend beyond both the 
sRGB space (the smallest trian-
gle) and the Adobe RGB space 
(the medium triangle). 
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ProPhoto in 16 bit 

Whenever I work in ProPhoto RGB, I always make sure that my image is in 16 bit 
mode. When working on a photo in 8-bit mode, the numbers that define colors 
range from 0 to 255. With 16-bit, we have thousands and thousands of color 
shades to describe our colors. The wider the color space we use, the more it be-
comes necessary to work in 16-bit mode. If we don’t, the image can end up with 
a bit of posterization, which creates an unappealing banding effect. 

RGB numbers in Photoshop

The Color Picker Inside the Color Pick-
er, we can enter in exact values for red, 
green and blue in order to create a spe-
cific color. It’s important to understand, 
however, that those same values will cre-
ate a different result when you type them 
into a document that uses a different col-
or space. If you would like to create a col-
or that is consistent across color spaces, 
use the LAB values within the color pick-
er. LAB does not have a working space 
attached to it. The numbers there are 
enough to describe the colors as a whole 
and therefore you can use those numbers 
to perfectly match colors between docu-
ments. 

The New Document dialog We are also presented with color profile settings 
when creating a new document. In the New Document dialog, there is a Col-
or Mode menu where we can choose between RGB, CMYK, etc. and if we click 
on Advanced Options, we will get a Color Profile menu where we can specify 

If you want to perfectly match a color from 
one document to another, use the LAB val-
ues, located within the Color Picker.
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which Color Profile to use (sRGB, Ado-
be RGB, etc.). Each of the color modes 
will have a default working space, and 
we can specify what the default working 
color space should be within the Color 
Settings dialog, which is located within 
the Edit menu. This dialog looks compli-
cated, but we only need to pay attention 
to the Working Spaces settings in the 
upper left. This is where we tell Photo-
shop what the default settings should be 
when creating new documents. 

Adobe Camera Raw (ACR)

ACR thinks about the range 
of colors that your camera 
captures. That range is not 
yet defined by a color space, 
but when it moves out of 
ACR and into Photoshop, it 
needs to have a color space 
attached to it. You can spec-
ify which color space to use 
by clicking on the line of text at the bottom, center part of the ACR interface. 
This text displays the color space that will be used. Change it by clicking on the 
text to get the Workflow Options dialog and then use the Color Space settings to 
specify which one should be used. 

Lightroom When we export an image from Lightroom, we need to specify what 
color space the image should have. In Lightroom’s Export dialog, we’ll find set-
tings for both color space and whether the image should be in 8 or 16 bit. We’ll 

The Color Profile setting within the New 
Document dialog. 

This text can be found at the bottom of an ACR window. 
Clicking on it will allow you to specify what color space 
should be used when the image is opened in Photoshop. 
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also find the color space settings in Lightroom’s Preferences, under External Ed-
iting. This is where we specify what color space should be used when we move 
an image from Lightroom into Photoshop (or another program). 

The Info panel We mentioned earlier that a document’s color space will be repre-
sented in the top left number set within the Info panel. It’s important to remem-
ber that a color is defined not only by the RGB values but also by the color space 
used. 

Working with color spaces between documents 

When looking at the same image in two different documents that contain two 
different color spaces, you will likely only notice a difference when you have really 
vivid colors in the image. 

To copy an image layer from one docu-
ment to another, use the keyboard short-
cut Command+A (Ctrl+A on Win) to se-
lect everything. Then go to the Edit menu 
and choose copy. Move to the document 
in which you’d like to place the image, go 
back to the Edit menu and choose Paste. 
If the destination document has a differ-
ent color space from the document you 
copied the image from, a warning dialog 
may appear. The warning will tell you that the color space between the two doc-
uments is different and it will ask if you’d like to convert the colors to the color 
space in the destination document. You can simply click ok to continue pasting 
the image into the destination document. 

If you try to paste an image into a doc-
ument with a different color space, this 
warning dialog will appear.
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Where to find the document’s color space

We already mentioned that you can set up 
the Info panel to display what color space 
the document is using. You can also display 
this information in the bottom left corner of 
the image window by clicking on the little 
arrow to the right of the text and choosing 
“Document Profile” from the popup menu. 

Additionally, when saving an image using 
the Save As command, you will see an “Em-
bed Color Profile” check box at the bottom 
of the Save As dialog. It’s extremely import-
ant that you always have that turned on 
when saving your images. If this setting is 
NOT turned on, the colors in the image will 
not look the same when you send the file 
to someone else. In order to accurately de-
scribe the colors in your picture, Photoshop 
needs to know what versions of red green 
and blue are being used. 

What to do with an untagged image

If you ever receive an image from someone that is untagged (lacking a color 
space), you can try and figure out which color space the image was created with 
and is supposed to use. In order to do this, switch between the different RGB 
working spaces and see which one makes the image look the most natural. To do 
this, go to the Edit menu and choose Assign Profile. This command will not change 
the information that’s in the picture and it won’t change the RGB numbers. It 
WILL change the colors of red, green and blue that those numbers refer to. In the 

We clicked on the arrow to the right of 
the text at the bottom of the document 
window and are choosing “Document 
Profile.”

When saving an image, always make 
sure the “Embed Color Profile” check 
box is turned on. 
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Assign Profile dialog, turn on the 
Profile box and switch between 
the different RGB workspaces. 
When you find the one that looks 
most natural, click OK. 

You can tell Photoshop to warn 
you any time you open an un-
tagged image by going to the 
Edit menu and choosing Color 
Settings. In the Color Settings di-
alog, turn on the “Missing Profiles: 
Ask When Opening” check box. 
With this setting on, Photoshop will give you a warning dialog any time you open 
an image that does not have a profile assigned to it. When you see this warning, 
you’ll know that the first thing you should do to your image is use the Assign Pro-
file command to specify a color profile. 

The Assign Profile command is being used on an 
image that was untagged (lacking a color profile).


